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INTRODUCTION AND WELCOME 

 

Welcome to the Camera Mouse 2018 user manual! 

 

Camera Mouse is a program that allows you to control the mouse pointer on a Windows computer 

just by moving your head. 

 

Camera Mouse uses a standard built-in camera or USB webcam to track your head.  If you move 

your head to the left, the mouse pointer moves to the left, and so on.  Clicking can be done by 

“dwell time”.  If you hold the mouse pointer within a certain area of the screen for, say, a second 

a mouse click will be issued by the program. 

 

The purpose of Camera Mouse is to help people with physical disabilities to access the computer.  

In particular, Camera Mouse has proved very helpful to people who have no voluntary movement 

below the neck, people who can voluntarily control only their head.  People with Cerebral Palsy, 

traumatic brain injury, ALS, Multiple Sclerosis, and various other disorders have used Camera 

Mouse to access the computer and internet. 

 

Camera Mouse has been put to many other uses as well. 

 

Copies of Camera Mouse, copies of this manual, information about programs that work well with 

Camera Mouse, answers to Frequently Asked Questions, and some videos about Camera Mouse 

can be found at cameramouse.org. 

 

Camera Mouse is completely free and may be distributed freely.   

 

Since the first version of Camera Mouse was made available for free in June 2007, over 3,200,000 

copies have been downloaded from cameramouse.org. 

 

 

 

INTRODUCTORY VIDEO 

 

 
 

See https://www.youtube.com/watch?v=x-y-7Cvm0k4 for an introductory video on Camera 

Mouse.  This is a good way to get started quickly. 

 

 

http://www.cameramouse.org/
https://www.youtube.com/watch?v=x-y-7Cvm0k4
https://www.youtube.com/watch?v=x-y-7Cvm0k4
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HARDWARE AND SOFTWARE REQUIREMENTS 

 

To run Camera Mouse 2018 you will need a computer or tablet with Windows 10, Windows 8.1, 

Windows 8, Windows 7, Windows Vista, or Windows XP.  Camera Mouse does not run on 

Windows RT. 

 

Your computer also needs Microsoft .NET Framework 4.0 or higher.  This already is installed on 

most computers, especially Windows 10 or 8 or 7.  If it is not installed on your computer, the 

Camera Mouse 2018 Installer will give you the option of downloading it from Microsoft.  You can 

download Microsoft .NET Framework 4.0 (for free) at http://www.microsoft.com/en-

us/download/details.aspx?id=24872 .  If you don’t have .NET Framework 4.0 or higher on your 

computer and can’t download it then you should try Camera Mouse 2013 or Camera Mouse 2011, 

which use older versions of .NET Framework and also are available on the cameramouse.org site.  

You can have Camera Mouse 2018, Camera Mouse 2017, Camera Mouse 2013, and Camera 

Mouse 2011 all installed on your computer at the same time. 

 

You also will need a built-in camera or a standard USB webcam.  We use a Microsoft LifeCam 

Studio HD or a Logitech HD Pro Webcam C920 for development.  The less expensive Microsoft 

LifeCam HD-3000 and Logitech HD C270 work well also.  Just about any good quality webcam 

should do, including most built-in webcams.  Inexpensive webcams, including some built in to 

notebook computers or tablets, can produce noisy or muddy images, which Camera Mouse can 

have a more difficult time tracking. 

 

It is very difficult for us to test Camera Mouse with all the combinations of computer hardware, 

Windows operating systems, and cameras.  If you have problems please notify me at gips@bc.edu. 

 

 

 

BEFORE USING CAMERA MOUSE 

 

If you are using a USB webcam, before using Camera Mouse you should install the webcam 

according to the instructions from the manufacturer.  Be sure to install the driver software for the 

webcam that comes with the webcam or the latest driver that is downloaded from the 

manufacturer’s website.  Do not try to use a generic Windows camera driver.  If you can, test to 

make sure the webcam works before using Camera Mouse, for example by using the Camera 

application that comes with Windows 10.  Place the webcam above or below your monitor so it is 

pointing at you.   

 

If you are using a notebook computer or tablet be sure it is resting on a table or desktop.  Camera 

Mouse will not function well with the computer or tablet on your bed or in your lap or in your 

hands. 

 

 

http://www.microsoft.com/en-us/download/details.aspx?id=24872
http://www.microsoft.com/en-us/download/details.aspx?id=24872
https://www.microsoft.com/accessories/en-us/products/webcams/lifecam-hd-3000/t3h-00011
https://www.microsoft.com/accessories/en-us/products/webcams/lifecam-hd-3000/t3h-00011
http://www.logitech.com/en-us/product/hd-webcam-c270?crid=34
mailto:gips@bc.edu
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GETTING STARTED WITH CAMERA MOUSE 2018           

 

Start up Camera Mouse 2018 by double-clicking on the shortcut icon on your desktop.  Initially 

you should see the following message 

 

 
 

 

On clicking OK you should see a window with a video screen that contains your face, like looking 

at yourself in the mirror.   
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Use the mouse to click on a unique feature of your face.  We usually use the inside corner of an 

eyebrow or eye or the ridge below the nose.  A green square should appear where you clicked.  

Move your head around very slowly at first.  The green square should track the feature.  If by 

chance it loses the feature, then move the mouse and select a different feature by clicking on it. 
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Once the feature on your face is being tracked by the computer, just press the Ctrl key or function 

key F9 or wait 4 seconds (“Auto start”).  Now the tracking of your head should control the mouse 

pointer.  As you move your head slowly to the right, the mouse pointer should move to the right.  

To return back to mouse control you can move the mouse or press the F9 key or the Ctrl key again. 

 

You can tell whether the mouse or the Camera Mouse is in control by looking below your picture 

in the Camera Mouse window. 

 

Select a target on the screen, perhaps an icon or a feature of the background picture.  See if you 

can move the mouse pointer to the target just by moving your head.  If you have difficulty reaching 

a portion of the screen, physically move the mouse to take back control, click on the Settings button 

to open up the Camera Mouse Settings window, and change the Gain settings as described below.  

Practice moving the mouse pointer around the screen with your head until it comes easy.   

 

If you haven’t already, you should download the Aliens and Paint program from the 

cameramouse.org Downloads page.  Also the Staggered Speech onscreen keyboard program from 

staggeredspeech.org and the Midas Touch program from midastouch.org. 

 

http://cameramouse.org/downloads.html
http://staggeredspeech.org/
http://midastouch.org/
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In Camera Mouse, click on a point on your face so it’s tracking.  Now open up the Aliens program.  

Try to keep your head steady so Camera Mouse continues to track.  Press the Ctrl key or the F9 

key or wait 4 seconds.  Move your head slowly.  The red crosshairs should move with your head.  

Now still with your head steady press the space bar.  The first alien should appear.  Move your 

head so the crosshair is on top of the alien.  You should hear and see an explosion as the alien 

blows up.  It’s just contact with the center of the crosshair.  No need for clicking with Aliens or 

Paint. 

 

Close Aliens when you are finished.  (But take a look at the manual or menus. You can substitute 

any photo for the Alien.) 

 

With Camera Mouse tracking your head, open up Paint.  Same procedure.  Press the spacebar and 

you are painting by moving your head.  You can change the colors and shapes in the menus.  Press 

the spacebar to stop at any time.  You can print the picture you have created with a dedication. 

 

Slow, deliberate movements with Camera Mouse are better than fast, jerky movements. 

 

 

 

RECENTERING 

 

Each time you start up Camera Mouse or switch control to Camera Mouse, the mouse pointer re-

centers.  (This can be changed in the Settings window; see below.)  So during a session a good 

way to center the mouse pointer in the screen is to press the Ctrl key or F9 key twice in a row. 

 

 

 

CHANGING THE FEATURE ON THE FACE THAT IS TRACKED 

 

At any time you can go into the main Camera Mouse window and use the mouse to click on a new 

feature on the face to track.  If you selected the tip of the nose and the green square is slipping, try 

the inside corner of the eyebrow or the ridge between the nose and mouth.  

 

 

 

MINIMIZING THE CAMERA MOUSE WINDOW 

 

You can minimize the Camera Mouse window by pressing the Minimize button at the top right of 

the window (the left of the three buttons). 

 

 
 

If the Camera Mouse window is minimized, the window will not appear but the Camera Mouse 

program will continue to run in the background and to track.  You can continue to use Camera 

Mouse to control the mouse pointer while the window is minimized.  The Ctrl key and the F9 key 
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and the mouse still will switch control back and forth to Camera Mouse even though the program 

is minimized.   

 

Minimizing the window can be a big help if a child is mesmerized by his or her appearance in the 

video window or if the Camera Mouse program is distracting the user from the application 

program. 

 

To bring the Camera Mouse window back from being minimized just click on the Camera Mouse 

tab (the green square) that should appear at the very bottom of the Windows screen. 

 

 

 
 

 

DISPLAYING THE IMAGE IN A SMALLER WINDOW 

 

By clicking on the button under the video image in the standard Camera Mouse window 

 

 

 
 

 

you can have the video displayed in a smaller window. 
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This window will always stay on top of any application on the desktop.  This is useful, for example, 

if you are monitoring the Camera Mouse program while someone else uses it.  You can drag the 

window down to say the bottom right of the screen and look at it now and then to see if the tracking 

slips.  You can still take control with the mouse and click on the smaller video window to reset the 

tracking.  To return the Camera Mouse window to its normal size click on the button below the 

video image. 
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CAMERA MOUSE SETTINGS 

Clicking the Settings button in the main Camera Mouse window  

 

 

 
 

 

brings up the Settings window 
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Settings uses a tab based interface with three pull-down menus (File, Camera, Help).  Let’s go 

through the various Camera Mouse Settings tabs, starting at the left. 

 

The question mark icon at the bottom right brings up the interactive Help feature for the current 

tab. 
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Clicking tab 
 

 

 
 

 

On start up, Clicking generally is off in Camera Mouse.   
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Clicking in Camera Mouse is done using “Dwell Time”.  That means that if you hold the mouse 

pointer on the screen within a certain small area for a certain period of time then a mouse click 

will be issued.   

 

If you turn on Clicking then you can change the Radius of the area and the amount of time during 

which the mouse pointer must be held in the area (the “Dwell Time”). 

 

 
 

A Dwell Time of 0.1 second allows for relatively rapid clicks, as might be useful in a video game.  

In general, 1 second seems to work well. 

 

 

 

PLAY CLICKING SOUNDS 

 

You can have the program alert you with a clicking sound whenever it issues a click by checking 

Play Clicking Sounds.  You can listen to the sound the program would make when a click is issued 

by clicking on the blue sound icon. 
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CLICKING RECOVERY TIME 

 

The Clicking Recovery Time provides the opportunity for a delay between a click and the next 

click.   

 

For example, if Clicking Recovery Time is checked and 2 Seconds is selected, then after each click 

the Camera Mouse program will wait for 2 seconds before beginning the examination of whether 

the mouse pointer is dwelling in a small area long enough to cause a click. 
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DOUBLE-CLICKING 

 

Once Clicking is turned on it’s possible to Enable Double Clicking. 

 

 

 
 

 

 

As soon as Enable Double Clicking is checked a new button appears in the main Camera Mouse 

window. 
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If the user clicks on the new “2-Click” button then the very next click will be a double-click.  So 

if the user wants to open Paint by double clicking on the Paint icon, the user would first click on 

the 2-Click button.  At this point the colors of the 2-Click button would be inverted to indicate it 

is active. 
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Then the user would use Camera Mouse to move the mouse pointer directly so it dwells over the 

Paint icon on the desktop, Camera Mouse would double-click (instead of single-clicking), and the 

Paint program would be opened.    

 

Clicking on the 2-Click button tells Camera Mouse that the very next click should be a double-

click. 
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RIGHT-CLICKING 

 

If Clicking is turned on it’s possible to Enable Right Clicking. 

 

 

 
 

 

As soon as Enable Right Clicking is checked a new button appears in the main Camera Mouse 

window. 
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If the user clicks on the “Right-Click” button then the very next click will be a right click (instead 

of a left click).  So if the user wants to right click, the user would first click on the Right-Click 

button.  At this point the colors of the Right-Click button would be inverted to indicate it is active. 

 



Camera Mouse 2018 User Manual December 14, 2017 Page 19 of 67 

 
 

 

Then the user would use Camera Mouse to move the mouse pointer directly so it dwells over an 

icon on the desktop, Camera Mouse would right-click (instead of left-clicking), and the right click 

menu for the icon would be opened. 

 

Clicking on the Right-Click button tells Camera Mouse that the very next click should be a right-

click. 

 

 

 

SINGLE-CLICK TO OPEN AN ITEM (WINDOWS SETTING) 

 

 
 

Double-clicking with Camera Mouse takes a while to get used to.  An alternative is to set up 

Windows so that programs, files, and folders are opened with a single-click instead of a double-

click.  This can be accomplished in the Windows Control Panel under Control Panel -> Appearance 

and Personalization -> Folder Options -> Specify single- or double-click to open.   
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Instead of going to the Windows Control Panel we put an option for this Windows setting on the 

Click tab of the Camera Mouse Settings.  This makes opening programs and files much easier 

using Camera Mouse.  Since this is a Windows setting it continues after Camera Mouse is closed. 

 

 

 

Control tab 

 

The Control tab determines how we can switch from mouse control (or trackpad control or touch 

control) to Camera Mouse control and back from Camera Mouse control to mouse control.   

 

 
 

 

 

If the mouse (or trackpad) has control there are three possible ways to begin Camera Mouse control 

of the mouse pointer: you can leave the mouse untouched for a couple of seconds, you can press 

the F9 key, or you can press the Ctrl key.  Which of these methods will work is determined in the 

“Begin Camera Mouse control when” setting with the green Go.     
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If the Ctrl key has meaning in the application program you are running, you can click off its use 

for Camera Mouse.  If function key F9 has an alternate meaning for you then you can click off its 

use or select any other function key from F1 through F12. 

 

Similarly, if Camera Mouse has control, there are four possible ways of switching back to mouse 

(or trackpad) control.  The easiest way is to just physically move the mouse (or slide your finger 

on the trackpad).  Or you can have a mouse click cause control to change from Camera Mouse 

back to the regular mouse.  Or you can press the F9 key or the Ctrl key.  Which of the three ways 

is enabled is determined by which boxes are checked under “End Camera Mouse control when” 

and the red Stop.     

   
 

If function key F9 has an alternate meaning for you then you can click off its use or select any 

other function key from F1 through F12. 

 

If you’d like, you can have Camera Mouse play a brief sound to alert you when control switches.  

Just click a check in the box next to “Play sound when control changes”.  You can hear the sound 

that would be played by clicking on the blue sound icon. 

     
 

 

 

  



Camera Mouse 2018 User Manual December 14, 2017 Page 22 of 67 

Exclude tab 

 

 
 

 

 

EXCLUDE FEATURE 

 

The Exclude feature prevents the mouse pointer from moving to the edge of the screen under 

Camera Mouse control.   

 

Initially, the Exclude values are all set to 0%, so no exclusion, as seen above. 

 

If the Top Exclude value is set to 10%,  
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then a red line will appear that percent of the way down the screen. 

 

 
 

 

Clicking anywhere will change the Exclude value, allowing for easy, precise location of the 

Exclude values. 

 

If more than one Exclude value appears 
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then the previously set Exclude values will be displayed as black lines and the newly set Exclude 

value will be displayed as a red line.  Again, clicking will change the Exclude value underlying 

the red line.  When happy with the position of the red line click on the Close button in the center 

of the screen. 

 

 
 

The user will be restricted to moving the mouse pointer to the area within the lines. 

 

The Exclude feature is included at the request of caregivers who like to run Camera Mouse but 

don’t want the people using the computer to be able to, for example, click on menus at the top of 

the screen or on other programs at the bottom of the screen or outside of the current window to the 

right or left.   

 

 

 

PAUSE FEATURE 

 

The Pause feature enables the user to pause Camera Mouse for a set amount of time, for example 

to read a web page or watch a video.   
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If you click on “Enable user to pause Camera Mouse operation” then a Pause button appears in the 

main Camera Mouse video window. 

 

 
 

 

Clicking on the Pause button, either with Camera Mouse or with the Mouse, pauses Camera Mouse 

and causes the Pause window to appear in the top left of the screen. 
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The Pause window counts down the time until Camera Mouse is resumed.   

 

The amount of time until Camera Mouse automatically resumes is determined by the pull-down 

menu in Settings 

 

 
 

 

When Camera Mouse resumes, it re-establishes the point to track using the method selected in the 

Settings. 

 

 
 

The 5-4-3-2-1 routine is explained in detail later.  Basically it allows the user to select the feature 

to be tracked by centering it in the white square displayed in the center of the screen as Camera 

Mouse counts down from 5 through 1. 

 

The Pause window can be closed manually by clicking on the Resume Camera Mouse button. 
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Sensitivity tab 

The Sensitivity settings determine how your head movements are translated into the mouse pointer 

movements.   

 

 

 
 

 

 

HORIZONTAL SENSITIVITY AND VERTICAL SENSITIVITY 

 

If the Horizontal Sensitivity is Low, then horizontal movements of your head result in relatively 

short horizontal movements of the mouse pointer.  If the Horizontal Sensitivity is Very High, then 

horizontal movements of your head result in relatively long horizontal movements of the mouse 

pointer.  The same for the Vertical Sensitivity.  There are eight possible settings for Horizontal 

and Vertical Sensitivity. 
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Often people have a more difficult time moving the head vertically than horizontally.  It is not 

unusual to set the Vertical Sensitivity higher than the Horizontal Sensitivity. 

 

An alternative to changing the Sensitivity settings is to go into the Camera pull-down menu and 

select Camera Settings.  The Camera Settings have been provided by the camera manufacturer.  

Within the Camera Settings there often is place to Zoom in or out.  Zooming in effect increases 

the Sensitivity. 

 

 

 

SMOOTHING 

Smoothing allows you to smooth out the jerkiness of the mouse pointer movements with some loss 

of control.  There are eight possible settings: 

 

 

 
 

 

Some people like little or no smoothing.  Some people like lots of smoothing.  Best is to experiment 

to determine personal preference. 
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Misc. tab 

 

The Misc. tab contains controls for Multiple monitors, Centering, Camera Mouse control of the 

feature to track, and Mirror image. 

 

 

 
 

 

 

MULTIPLE MONITORS 

 
 

If you have a single monitor (screen) on your computer this setting is grayed out and is not 

applicable. 
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If you have multiple monitors this setting determines whether Camera Mouse will move the mouse 

pointer across just the main monitor or across all the monitors connected to the computer. 

 

 

 

CENTERING THE MOUSE POINTER 

 

You may not notice at first, but Camera Mouse automatically re-centers the mouse pointer in the 

middle of the screen each time Camera Mouse begins control. 

 

Thus if Camera Mouse has control and you press the Ctrl key twice then control will switch over 

to the mouse and then back to Camera Mouse and the mouse pointer will be placed in the center 

of the screen. 

 

Some Camera Mouse users emailed to request that we provide other options for when Camera 

Mouse should place the mouse pointer in the center of the screen. 

 

 
 

The two other choices are to re-center the mouse pointer whenever a new feature on the face is 

selected and to never have Camera Mouse re-center the mouse pointer. 

 

 

 

ALLOW CAMERA MOUSE TO CLICK ON THE VIDEO IMAGE ON THE SCREEN AND 

CHANGE THE FEATURE BEING TRACKED 

 

 
 

The question here is whether the user can change the feature being tracked by clicking on the new 

feature of the face in the video image using Camera Mouse.  A bit subtle.  We used to allow this 

but then at user request we eliminated it so that clicking on the video image with Camera Mouse 

would have no effect on the track point (green square).  A user from Russia sent an email (in 

Russian) requesting the return of this feature.  So we added it as an option for the user. 
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REVERSE HORIZONTAL MOVEMENT 

We think the most natural way to use Camera Mouse is for the video window to look like a mirror.  

So that when you move your head to the right, the image of your head seems to follow you to the 

right.   

 

Some people prefer it reversed so that when you move your head to the right the head in the image 

moves to the screen’s right which is to your left.  The Reverse Horizontal Movement checkbox 

allows you to reverse the horizontal movement. 

 

 
 

Note that this may be complicated by the Camera Settings.  Most cameras have their own Settings 

window.  You can access this window by selecting Camera Settings in the Camera pull-down 

menu. There you’ll probably find a Mirror Horizontal setting or something similar.  We suggest 

you keep this camera setting off.  It can get unnecessarily confusing. 
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Start-Up tab 

 

The Start-Up tab allows you to change how the feature to track is acquired when Camera Mouse 

is started and also allows you to determine whether or not Camera Mouse is run automatically 

when your computer is started. 

 

 

 
 

 

 

ACQUIRING FEATURE TO TRACK AT PROGRAM START-UP 

 

There are three possible ways that Camera Mouse can acquire the point to track when the program 

begins. 
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The traditional way is for the user to click on the point on the face to track.  In the figures above 

we have used the corner of the eye.  Some people use the ridge on the face between the nose and 

mouth (difficult with a beard).  Some people use the tip of the nose.  You can even put a small 

bandage on your forehead or mark an X.  If you wear glasses a good spot to track is some unique  

shape on the structural elements. 

 

 

 
 

The second alternative is to have Camera Mouse run the 5-4-3-2-1 routine whenever the program 

is started.   
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What is the 5-4-3-2-1 routine?  It is a way of setting the point on the face that is being tracked.  

When the 5-4-3-2-1 routine starts a white square (not a green square) appears at the very center of 

the screen and a white 5 appears on top of it. Camera Mouse then counts down from 5 to 4 to 3 to 

2 to 1.  The idea is to move your face so the feature you want to track is under the white square 

when the countdown ends. 
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The third alternative is to have Camera Mouse automatically try to find the corner of the eye to 

track on start up.   

 

 
 

Of course, once a feature has been selected it can be changed by clicking on a feature to be tracked. 
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RUN CAMERA MOUSE AUTOMATICALLY WHEN COMPUTER STARTS 

 

 
 

People who use Camera Mouse all the time can select “Yes” here and have Camera Mouse run 

automatically whenever the computer is started. 

 

 

  



Camera Mouse 2018 User Manual December 14, 2017 Page 38 of 67 

5-4-3-2-1 tab 

 

In addition to running the 5-4-3-2-1 routine on the start-up of Camera Mouse, there are four other 

ways the 5-4-3-2-1 can be initiated depending on which boxes are checked in the 5-4-3-2-1 tab of 

Settings. 

 

 

 

Again, the 5-4-3-2-1 routine puts a white square in the middle of the screen.  The idea is for you 

to move so that the point you want to track is in the middle of the white square when the computer 

counts down from 5 to 4 to 3 to 2 to 1.  Whatever is in the middle of the white square at 1 will be 

tracked by the green square 
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Whatever feature on the face is in the middle of the white square at 1 will be tracked by the green 

square 
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If you click on the box “Run 5-4-3-2-1 routine on F5 key press”  
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then you will be able to run the 5-4-3-2-1 routine whenever you press the function key F5 on the 

keyboard.  As you can see if the F5 key has some other meaning then you can change the function 

key that runs 5-4-3-2-1. 

 

 

 
 

 

If you click on “Place 5-4-3-2-1 button on video window” 

 

 
 

then a new button appears on the Camera Mouse window.  Clicking on the button (either with the 

mouse or with Camera Mouse) triggers the 5-4-3-2-1 routine. 
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If this option is selected, the 5-4-3-2-1 button also appears on the smaller window. 

 

 

 
 

 

If you click on the option “Run 5-4-3-2-1 routine on loss of trackpoint” 
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then if the head moves off the screen and Camera Mouse loses tracking the 5-4-3-2-1 routine will 

be run automatically.   

 

 

 
 

If you click on the option “Automatically run 5-4-3-2-1 every 3 minutes then, yes the 5-4-3-2-1 

routine will be run every 3 minutes.  The 3 is changeable to any value between 1 and 10. 

 

 

 

CENTER TRACKPOINT ON ALT KEY PRESS 

 

If you click on “Center track point on Alt key press” then whenever you press the Alt key on the 

keyboard, Camera Mouse immediately will change the feature on the face that is tracked to 

whatever is at the exact center of the video screen at that moment.  This acts like 5-4-3-2-1 but 

without all the preliminaries. 
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As soon as you click on “Center track point on Alt key press then a new option is available “Display 

blue dot at center of video image”.  The purpose of this option is to enable the operator to see what 

is at the center of the video image and exactly which feature would be selected by pressing the Alt 

key. 
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MENUS 

 

Now let’s take a look at the menu items. 

 

 

 

File menu 

 

 

 

 

Different Camera Mouse Settings might be used with different software or by different people.  

With Camera Mouse you can Save the settings through the File pull-down menu. 

 

 

SAVE AS … 

 

The Save As… menu option allows you to give the current settings a name and then save them on 

the disk for future use.  ALL of the settings under all the tabs are saved in one file.  For example, 

to save Maria’s settings: 
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SAVE AS DEFAULT 

 

Save As Default allows you to save the current settings as the default settings.  These are the 

Camera Mouse Settings that the program uses automatically when it is started up. 

 

 

 

OPEN 

 

Open allows you to Open a previously saved Camera Mouse Settings file.  
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If the file you select was not saved by the current Camera Mouse version the program will not be 

able to open the file and you will receive a message to that effect. 

 

 

 
 

 

OPEN DEFAULT 

 

Open Default allows you to open the current default file.  The current default settings become the 

new settings for Camera Mouse. 
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USE FACTORY SETTINGS 

 

If you want to return to the original settings that came with the program from the “Factory” select 

Use Factory Settings in the File pull-down menu.  This changes the Settings in the window.  They 

then can be saved on the disk as the default through the File menu.   

 

 

 

EXIT 

 

Selecting Exit in the File menu causes the Settings Window to close.  Selecting Exit is the same 

as clicking on the OK button at the bottom of the Camera Mouse Settings window. 
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Camera menu 

 

 
 
 

 

CAMERA  SETTINGS 

 

Camera Settings takes you to the control window for the USB camera you are using.  Camera 

Settings are provided by the manufacturer of the webcam you are using.  For example, with my 

Logitech HD Pro Webcam C920 camera here’s the window I see when I first click on Camera 

Settings: 
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The most useful control here is the digital zoom control for the webcam. 

 

 
 

By adjusting the zoom you can adjust the size of the face in the video window.  In the examples 

above the zoom control is one notch up so the face appears to be larger in the video window than 

with the default webcam setting, which is at the lowest setting.   

 

If the facial feature with the Camera Mouse track point often moves off the edge of the screen then 

it would be good to zoom out the camera some more if you can.  The Gain settings and the zoom 
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counteract each other in the sense that if you are way zoomed out then you might need higher 

Horizontal and Vertical Gain settings. 

 

Note that you usually want “Follow my face” unclicked or off (or “Automatic Face Tracking Off”) 

in the Camera Settings because Camera Mouse is doing face tracking and if your camera is also 

then the two can counteract each other in strange ways. The only exception we have found is if the 

person using Camera Mouse has large spastic movements of the head. Then putting on automatic 

Face Tracking in the camera might prove useful.  

 

Usually you want Auto-focus turned on, as above. 

 

Clicking on the Advanced Settings tab shows the following window: 

 

 

 
 

 

Using “RightLight” usually is good because this causes the camera driver to automatically adjust 

the brightness and coloring for best viewing and also for best tracking. 
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CHANGE VIDEO SOURCE 

If there is just one camera or source of video connected to the computer or tablet then the Change 

Video Source menu item will be gray and not able to be selected. 

 

If two or more cameras are connected to the computer or tablet then you can choose this menu 

item to change the cameras for Camera Mouse if you would like  

 

 

 
 

 

This menu item also is useful if you have a television tuner or other non-related video source 

connected to your computer. 

 

 

 

  



Camera Mouse 2018 User Manual December 14, 2017 Page 54 of 67 

Help menu 

 
 

 

 

INTERACTIVE HELP and USER MANUAL 

 

The Help menu can be used to call up the Interactive Help facility as well as this manual. 
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WELCOME MESSAGE 

 

The Welcome Message selection displays the message box that was displayed after the Camera 

Mouse program first was installed. 
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ABOUT 

 

The About selection displays the About box: 

 

 

 
 

 

The About box shows the version number of the software you are using. 
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EULA 

 

Selecting EULA in the Help menu shows the End User Licensing Agreement (EULA) for 

Camera Mouse. 
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HINTS FOR IMPROVING TRACKING 

 

The quality of tracking in Camera Mouse obviously is very important for the performance and 

usefulness of the program.  We work all the time to improve the tracking.  Here I would like to 

discuss measures that you can take to improve the tracking. 

 

 

BE SURE THE NOTEBOOK OR TABLET IS ON A TABLE OR DESK 

 

The most common mistake that people make is to try to use Camera Mouse with the computer on 

their lap or while lying in bed or with the tablet in their hands.  To track well, it is vital that the 

camera, and usually that means the computer or tablet, is resting rock solid on a table or desk.  If 

you are using a Windows tablet you should get a stand for it if you don’t have one. That is why 

we added the Welcome message to Camera Mouse. 

 

 

FEATURES THAT TRACK WELL 

 

As the green square is intended to indicate, Camera Mouse is tracking just a small square area on 

your face.  In its tracking Camera Mouse does not understand faces or facial features at all, just 

small square areas.  That area should be as unique in its visual content as possible.  For example, 

clicking on an area in my forehead is not a good idea.  One part of my forehead looks just the same 

as other parts of my forehead, so the tracking point as indicated by the green square is likely to 

slip and slide across my forehead.  From visual inspection and from experience, good spots to track 

are at the corner of my eye or the corner of my eyebrow.  If I didn’t have a moustache then the 

ridge between my nose and mouth probably would work well.  My nostril can work OK.  The 

bridge on my glasses works well if I am wearing glasses.  Putting a piece of adhesive tape or 

masking tape with an X drawn in black ink on my forehead works well.  Here is me with a square 

cut from a Post-It with an X drawn on it to illustrate. 
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LIGHTING 

 

The lighting is very important.  You want high contrast on the face.  A bright light or bright window 

behind the head can darken the face and make it difficult for Camera Mouse to track.  Of course 

the lighting can change during the course of the day and into the night.  Lighting that works well 

at noon might not work at 5 pm or at 9 pm.  You also want high contrast as the user moves or turns 

his head so be careful of strong lighting from one side.   

 

 

QUALITY OF CAMERA 

 

The quality of the camera being used is very important.  I recently bought a not inexpensive 

notebook computer that has a terrible built-in camera. The video image just looks muddy.  

Unfortunately, it seems that the well-known manufacturer decided to save money by building in a 

low quality camera.  I find myself attaching a Logitech HD Pro Webcam C920 or Microsoft 

LifeCam Studio HD to the notebook. 
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CAMERA SETTINGS 

 

Experiment with the Camera Settings. 

 

 

 
 

 

 

ZOOM 

 

Especially experiment with the camera zoom, if your camera allows changes in the zoom.  Here is 

low zoom. 
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Here is high zoom. 

 

 
 

 

With high zoom my head more than fills the video image.  Natural head movements cause the area 

being tracked to move out of the video image thereby automatically causing Camera Mouse to lose 

tracking, though it does reacquire usually a different track point when you move your head back 

in to the video image. 

 

 

AUTOFOCUS 

 

Autofocus also can be an issue.  With some cameras they frequently go into autofocus mode, 

changing the focus, and the result is the loss of the trackpoint in Camera Mouse.  Sometimes I turn 

off Auto Focus and set the focus manually as for Camera Mouse the user stays at the same distance 

from the camera throughout the session. 
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The bottom line is that many environmental factors affect tracking.  Best is to experiment to see 

what works best for you in your specific environment. 
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MAKING THE MOUSE POINTER LARGER AND EASIER TO SEE 
 

Some people report “losing” the mouse pointer on the screen when using Camera Mouse. 

 

You can make the mouse pointer larger than usual and thus easier to see using the Windows 

Control Panel.  (These instructions are for my Windows 10.  Other versions of Windows are similar 

but may not be exactly the same.) 

 

Right click on the Windows icon at the very bottom left of the screen and then select Control Panel 
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In the Control Panel select Ease of Access. 

 

 
 

 

In Ease of Access select Change how your mouse works.   
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Then select the size and type of mouse pointer you would like 
 

 
 

 

And click OK.   

 

This should make the mouse pointer more visible and Camera Mouse easier to use. 

 

 

 

  



Camera Mouse 2018 User Manual December 14, 2017 Page 66 of 67 

WHO IS RESPONSIBLE FOR CAMERA MOUSE? 

 

Camera Mouse was invented by Prof. James Gips (Boston College) and Prof. Margrit Betke (then 

at Boston College, now at Boston University) in 1999-2000.  The initial version was developed by 

Peter Fleming and then Chris Fagiani, who were undergraduates at Boston College.  The initial 

version made use of a $1,000 Sony pan-tilt-zoom video camera and a special purpose video capture 

board.   

 

The first prototype using a USB webcam was developed by Jon Gips.   

 

The Camera Mouse technology was licensed by Boston College to Camera Mouse, Inc., a start-up 

company based in Texas, in 2004.  They developed and sold a webcam-based commercial version 

of the program for $495 and then $395, but couldn’t make a financial success of it.  The company 

went bankrupt and the license for Camera Mouse was returned to Boston College. 

 

In 2007 Wajeeha Akram, a graduate student at Boston University working with Prof. Betke, 

developed a research version of Camera Mouse.   

 

Camera Mouse 2007 was engineered and implemented under contract with Boston College by 

Donald Green, of Mekinesis, with the functional specifications of the program developed by Jim 

Gips. Don and Jim and Matt McGowan continued to expand and improve the program in releases 

of Camera Mouse 2008, 2009, 2010, and 2011.  In 2009-2010 Sophia Yen advised us on how to 

put the whole Camera Mouse project on a strategically sound path. Camera Mouse 2012 was a 

complete rewrite.  The functional specifications, user interface, and overall project are the 

responsibility of Jim Gips.  Don Green headed the software engineering working with Christine 

Hsu Nason, his former colleague at OpCode Consulting.  Now Don works on the software 

engineering through Mekinesis, his consulting company.  The automatic feature detection routine 

for locating the eye on start-up is based on work by Yinghao Cai when she was a Visiting Scholar 

at Boston College.  Camera Mouse 2013 was directly based on Camera Mouse 2012.  Camera 

Mouse 2014 was designed to work better with Windows 8 and 8.1. Camera Mouse 2015 added 

some requested options (Clicking Recovery Time, Center on Alt key press) and was designed to 

work with Windows 10 as well as past versions of Windows.  Camera Mouse 2016, Camera Mouse 

2017, and Camera Mouse 2018 add some features requested by users, for example the ability to 

click on the exact locations of the exclude zones. 

 

Our efforts currently are supported by gifts from the Philanthropy Committee of Mitsubishi 

Electric Research Labs (MERL) and Mitsubishi Electric America Foundation, for which we are 

most grateful.  Boston College is most generous in its continuing support.  
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QUESTIONS OR SUGGESTIONS? 

Prof. James Gips 

Fulton Hall 460 

Boston College 

Chestnut Hill, MA 02467 

 

cs.bc.edu/~gips 

gips@bc.edu 

 

 

Please see the website at cameramouse.org for more information about Camera Mouse and for 

information about programs that can be used about Camera Mouse and for answers to questions 

that may not be answered in this manual.   

 

The Camera Mouse Facebook page is at https://www.facebook.com/cameramouse.  It is a good 

way to keep current with Camera Mouse and to share your experiences with Camera Mouse.   

 

 

Thank you for using Camera Mouse! 

 

http://www.cs.bc.edu/~gips
mailto:gips@bc.edu
http://www.cameramouse.org/
https://www.facebook.com/cameramouse

